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Overview

Welcome to Nikon View Ver.2 for Macintosh (below, Nikon
View), a companion program for the COOLPIX 700, COOLPIX
900 Series, and the COOLPIX 950 (below, “COOLPIX digital
cameras”).  Nikon View allows you to connect your camera to a
Macintosh for quick retrieval and browsing of the images stored
in your camera.  Once Nikon View is installed on your
Macintosh, the camera can be used like any other drive, allow-
ing free access to images in the camera via standard Mac OS file
operations.  Nikon View Browser is also provided, making it
possible to display the contents of the camera’s memory as
thumbnail images.  Once you have installed Nikon View and
mastered its simple operation, you’ll be able to distribute your
digital photographs by disk or electronic mail, or include them in
your home page and other documents you create for business
or personal use.

Nikon View’s features include those listed below.

• a driver function that supports connection to your camera
and allows you to operate your camera’s memory like any
other drive

• thumbnails viewed in Nikon View Browser can be copied to
disk or opened in other applications using drag and drop

• images in the camera’s memory can be handled using stan-
dard Mac OS file operations
Overview
• images can be opened in any application that supports JPEG
or TIFF for retouching or to be saved in another format,
allowing you to use images as desktop pictures or distribute
them by electronic mail

• if you have a compact flash-memory reader or a PCMCIA
card slot and card adapter, the digital camera’s compact
flash-memory cards can be browsed even when not inserted
in the camera
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This manual will guide you, step-by-step, through the process of
using Nikon View with your digital camera.  For details on Nikon
View installation and system requirements, refer to the ”Quick
Start Guide.”

The Manual Layout

The contents of each chapter are outlined below.

Overview
Describes Nikon View’s features and outlines the contents of
this manual.

Setting Up the Camera Drive
Explains how to mount and unmount the camera.

Working with Images
Explains how to access images stored in the camera’s
memory, open them in other applications for editing, and
copy them to disk.

Nikon View Browser
Describes how to display images as thumbnails, view images,
and copy them to disk using Nikon View Browser.

Nikon View Reference
A handy reference guide to Nikon View’s windows and
menus.
Overview
With Different Operating Systems

The illustrations and explanations in this manual are for Mac OS
8.5.  Display and operation may differ slightly in other versions
of Mac OS.  Refer to the System Software manual for the
version you are using.

On Symbols in This Manual

The ✔ symbols in this manual signify the need for caution when
using the product.  These indications are placed in sections that
should be read before operation to prevent damage to the
product.

Working Knowledge

This manual assumes a basic understanding of common Mac OS
operations.  If you are in doubt about the meaning of terms
used here, refer to your Mac OS manual.
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Setting Up the Camera Drive

Once you have installed the Nikon View software as described
in “Quick Start Guide,” you can mount the camera.  The
mounted camera drive icon is displayed on the desktop, just as
with any other drive.  This chapter describes how to mount the
camera, choose settings, and unmount the camera.

Mounting the Camera

Follow these steps to mount your camera as a drive.

1 Connect the camera to your Macintosh as described in the
documentation provided with your COOLPIX digital camera.
Setting Up the Camera Drive:  Mounting the Camera
2 After turning on your Macintosh, choose Nikon View
Control from the Control Panels submenu of the Apple
menu ( ).

Short-cut:  Select Open Nikon View Control… from the
Nikon View item menu on the control strip.  The Nikon View
Control window will be displayed.
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Create Thumbnails

If the Create Thumbnails box is checked, thumbnail previews of the images

in the camera will be created when the camera is first connected as a drive.

When you open the Image Folder in the mounted CoolPix camera drive,

the image file is displayed as a thumbnail icon.  These thumbnails will be

displayed in Nikon View Browser (see below), and in the Open dialog box

viewing images in the CoolPix camera drive.

3 From the Port option pop-up menu, choose the appropri-
ate connection port (“Modem Port” or“Printer Port”).

Note:  PowerBook users who have connected the camera to the
printer/external modem port should turn AppleTalk off and then
select “Modem Port” in the Port option.
Setting Up the Camera Drive:  Mounting the Camera
Setting camera drive options
Click the Options… button to open the options dialog box
and choose the following settings.

• the application used to open camera files (the default is
the built-in viewer in Nikon View Browser)

• the speed of the connection between the camera and the
computer’s modem/printer port (the default is “Auto”)

• alternate drives, in place of the camera (mounting com-
pact flash-memory cards inserted in card readers, a com-
puter card drive)

For details, see “Camera Drive Option Settings,” in the next
section.

Tips

Depending on your set-up, auto data-rate detection may not perform as

expected.  Should you experience problems reading the data stored in the

camera, select a new speed in the options dialog.  If you still experience

difficulties at the highest available rate, choose successively lower speeds

until you find one that works.
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4 Once any changes to settings have been made, click Mount
Now to connect the camera.
The following message will be displayed while the computer
connects to the camera.

✔Caution:  The data-transfer icon in the camera’s control
panel is displayed while the computer communicates with the
camera.  The data-transfer icon is displayed for up to sixty seconds
after transfer of data is complete.  Do not disconnect the camera
while the icon is displayed.  (The data transfer icon varies accord-
ing to your camera model.)

The data-transfer icon
(COOLPIX 950)
Setting Up the Camera Drive:  Mounting the Camera
Once the camera has been selected as a drive, a CoolPix
icon will appear at the right side of the desktop with the
computer’s other drives.

Resolving connection error
If Nikon View is unable to locate the camera, an alert dialog will
appear.  After clicking OK in the dialog, check that the camera
and computer are connected and that the camera’s selector dial
is not set to OFF.  If the data transfer icon is not showing in the
camera’s control panel, check whether the serial cable is prop-
erly connected and that the batteries are properly inserted and
are not dead.  If you are using the AC adapter, be sure that it is
properly connected.  Refer to the ReadMe file for the latest
information on connection errors.  The ReadMe file contains
updates that are not included in the manual.
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Mounting the camera without changing port and
option settings
Once you have connected to the camera using the Nikon View
Control window to specify a port and other settings, the next
time you want to connect to your camera using the same
settings you can connect directly without using the Nikon View
Control window.  To connect directly to the camera, choose
Nikon View Mounter from the Apple menu ( ).

Short-cut:  From the Nikon View item menu on the Control
Strip, choose Mount Camera Now.
Setting Up the Camera Drive:  Mounting the Camera
Camera Drive Option Settings

You can choose camera drive option settings when you mount
the camera.

Clicking Options… in the Nikon View Control window dis-
plays the following options dialog:

Choose the following settings in this options dialog.  Click the
OK button to return to the Nikon View Control window.
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Choosing the application used to open camera files
You can choose the application used to open image files in the
camera memory.  The application used by default is Nikon View
Browser (built-in viewer).

To use a different application, click the Change… button.  In
the dialog that appears, navigate to a folder containing an appli-
cation that supports the file formats used by the camera.  Select
the application and click Open.

Setting Serial Port Speed
The data transfer rate used when the camera is connected to
the computer via the modem/printer port can be chosen from
the Port Speed option pop-up menu.  Choose “Auto” to
have Nikon View automatically select a speed suited to your
Macintosh.

Note:   Depending on your set-up, auto data-rate detection may
not perform as expected.  Should you experience problems reading
the data stored in the camera, select a new speed from the Port
Speed option pop-up menu.  If you still experience difficulties at
the highest available rate, choose successively lower speeds until
you find one that works.

the application used to open image files
Setting Up the Camera Drive:  Camera Drive Option Settings
Mounting the compact flash-memory cards
When the Mount CoolPix PC-Cards using Nikon View
check box is selected, compact flash-memory cards (only
COOLPIX digital camera cards may be used) in a computer
card drive, or card-readers are mounted as the CoolPix camera
drive.  After it is mounted,  you can carry out image file opera-
tions just as when you mounted the camera.
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Unmounting the Camera

When you turn off your Macintosh, the camera will be un-
mounted automatically.  To unmount the camera without
turning off the computer, use one of the methods given below.

Drag the CoolPix icon into the Trash
The camera can be unmounted by dragging the CoolPix icon
into the Trash.

Camera drive folders will close and the CoolPix icon will
disappear from the desktop.
Setting Up the Camera Drive:  Unmounting the Camera
Select Nikon View Mounter from the Apple menu
Select Nikon View Mounter from the Apple menu ( ).  The
following message will be displayed.

Camera drive folders will close and the CoolPix icon will
disappear from the desktop.

Alternatively, you can choose Nikon View Control from the
Control Panels submenu of the Apple menu ( ) and click
Unmount Now in the Nikon View Control window.

Short-cut:  Select Unmount Camera Now from the
Nikon View item menu on the Control Strip.  Or, click the
CoolPix icon, then select Put Away ( Y) from the File
menu.
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Notes on Using the Camera as a Drive

Nikon View allows the camera’s memory to be used in much the
same way that you would use any other drive.  Note however
that certain limitations apply as listed below.

Only one camera is supported at a time:
If two cameras are connected, one to the modem port and the
other to the printer port, you can switch between cameras
using the Nikon View Control window.

The camera cannot be shared over a network:
The camera will not function as a network drive.  Consequently
the CoolPix icon will not be visible to other computers.

The camera’s memory is locked:
The camera’s memory is treated as a locked drive—files cannot
be copied from other folders to the image folder in the camera
drive, nor can files be saved to the camera after editing in
another application.  Because the camera functions as a locked
drive, images can not be deleted using the computer.  Delete
images using the camera’s delete function.  The file names
displayed in the image folder in the camera drive cannot be
changed.  Should you wish to change a file name, do so after
copying the image to disk.
- 11 -Setting Up the Camera Drive:  Notes



Working with Images

Once the camera is connected as a drive, as described in the
previous sections,  you can use the camera’s memory with
Nikon View in much the same way that you would use any other
drive under Mac OS.  This chapter describes how to copy
images taken with the COOLPIX digital camera to disk, and
how to open them for editing in other applications.  These
operations are much the same as standard Finder operations;
consult your Mac OS manual for details.

Viewing the Items in the Camera’s Memory

Follow these steps to view images stored in your digital
camera’s memory.

1 Double-click the CoolPix icon at the right side of the
desktop.
Working with Images:  Viewing the Items in the Camera’s Memo
The CoolPix camera drive window opens, and folders saved
in the camera memory are displayed.

2 Double-click the folder icon that you want to browse.

Folder Names

When displayed in Nikon View, folders created with the camera are prefixed

by a three-digit folder number.  Thus the default folder, which  when viewed

from the camera menus has the name “NIKON,” is displayed in Nikon View

as “100NIKON.”  Each folder can hold up to 999 images.  If this number is

exceeded, the camera will create a new folder with the same name but a

different prefix (e.g., “101NIKON”).  When viewed on a computer, folders

with the same name but a different prefix appear as separate folders.  When

viewed from the camera menus, however, folders with the same name ap-

pear to be the same folder, although the full folder name with prefix ap-

pears in the photo information display in playback mode.
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The images in the selected folder will appear as thumbnails
icons.

Images can be copied to disk or opened for editing in an-
other application using standard Finder operations, as de-
scribed below.

Tips

When the camera functions as a drive, it is treated as a locked disk.  Files

cannot be copied or saved to the camera, nor can images in the camera be

dragged into the Trash.  Use the camera’s delete option to delete images

from the camera.  Similarly, the Finder commands New Folder, Move to

Trash, Duplicate, Make Alias, Put Away, Eject, and Erase Disk cannot

be used on the camera or the images it contains.
- 13 -Working with Images:  Viewing the Items in the Camera’s Memory



Copying Images to Disk

Before copying images to disk, locate or create the destination
folder.  To copy images to disk, select the images you wish to
copy by clicking their icons (you can select multiple images by
holding down the shift key while clicking each image in turn),
then drag any of the selected icons over the destination folder
and release the mouse button.

Note:  Because the camera functions as a locked drive, images
can only be copied, not moved, even if the option key is not held
down.
Working with Images:  Copying Images to Disk
Tips

 All images taken with the camera are assigned file names beginning with

“DSCN0001.JPG (or TIF).”  Likewise, all image files saved in folders in the

camera memory are assigned file names beginning with “DSCN0001.JPG

(or TIF).”  Thus, to prevent overwriting when copying an image to disk,

change the filename when you copy an image, or create a new copy folder

for each camera folder.
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Opening Images in Another Application

The images can be opened in the associated application either
by double-clicking the image icon or by selecting Open from
the Finder’s File menu.  Images can also be opened directly
from any application that supports the file formats used by the
camera.

Opening selected images from the image folder
To open images, select the images you wish to open by clicking
their icons (multiple images can be selected by holding down
the shift key while clicking each image in turn), then double-click
any of the selected thumbnails or choose Open from the File
menu.
Working with Images:  Opening Images in Another Application
The application will start and the selected images will be
opened in windows within the application.

Tips

The application used to open camera image files is the one that you se-

lected in the Nikon View Control Window, when you mounted the camera.

If you selected the default “Nikon View Browser,” it will start, and you can

view images at full resolution using the browser’s built-in viewer.  For de-

tails, see “Nikon View Browser: Viewing Images with the Bult-in Viewer.”  If you

chose another application, that application will start, and open the images.

If the specified application is not installed when you attempt to open an

image, a dialog will appear prompting you to choose the application to be

used.  Choose a suitable application from the dialog box.
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Opening selected images by drag and drop
You can open selected images in any application that supports
the file formats used by the camera by dragging their thumbnails
over the application’s icon or alias and releasing the mouse
button.

The application will start and the selected images will be
opened in windows within the application.
Working with Images:  Opening Images in Another Application
Opening images from the application’s Open dialog
Images in the camera can be opened from any application that
supports the file formats used by the camera by choosing
Open… or Open File… from the application’s File menu.  In
the Open dialog, navigate to the Desktop, select the “CoolPix ”
drive, and click the Open button.  The folders in the camera
memory are displayed; choose the one you want and click the
Open button.  The images in selected folder will be listed.  If
the application’s Open dialog supports preview display, a pre-
view of the image currently selected will appear in the dialog
box.

Select the image you wish to open and click the Open button
to open the image in the application.

Note:  Previews is only displayed in the Open dialog box if the
Create Thumbnails item in the Nikon View Control window
was checked when the camera was mounted.
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Nikon View Browser
Nikon View Browser is a utility that allows you to browse the
images in the camera’s memory as thumbnail previews.  It also
incorporates many Finder functions, making it easy to copy or
open images while viewing them in preview.  This chapter
describes how to browse images using Nikon View Browser, how
to display images in the browser’s built-in viewer, how to copy
images to disk, and how to open images for editing in other
applications.

Browsing Images in Your Camera

To start Nikon View Browser and view thumbnail previews of the
images in the camera’s memory, double-click the Browse
Thumbnails icon in the CoolPix window.

Note:  The Browse Thumbnails icon is only visible if the
Create Thumbnails item in the Nikon View Control window
was checked when the camera was mounted.
Nikon View Browser:  Browsing Images in Your Camera
The browser windows for all folders in the camera memory will
open and the images will appear as thumbnails.

From the browser window, you can select images to be opened
in another application, printed, or copied to disk.  You can also
use the built-in viewer to view images at full resolution.  These
operations are detailed in the sections that follow.
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Another way of starting Nikon View Browser
Follow these steps to start Nikon View Browser and view
thumbnail previews of the images in the camera’s memory.

1 Drag the CoolPix icon over the Nikon View Browser
icon and release the mouse button.

Note:  “Nikon View Browser” may be found in the path “(Instal-
lation Disk)|(Installation Folder)|Nikon Software|Nikon View
2|Nikon View Browser.”
Nikon View Browser:  Browsing Images in Your Camera
The CoolPix window opens, and folders saved in the camera
memory are displayed.

2 Double-click the folder icons that you want to browse.
Nikon View Browser will start, and the browser window will
show thumbnail previews of the images in the selected
folder.

Nikon View Browser can also be started by double-clicking the
Nikon View Browser icon.

A dialog will appear prompting you to select a folder to browse.
Select the desired folder and click Select.
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Browsing Compact Flash-Memory Cards

If your computer has a Type II PCMCIA card drive, you can
read compact flash-memory cards using a flash-memory adapter
(available separately from Nikon).  Compact flash memory can
also be read using a compact flash card-reader.  If a card con-
taining images recorded by a COOLPIX digital camera is in-
serted in either device, its contents can be browsed from the
browser window.  If another card is inserted in the camera, and
the camera is connected to your computer, you can simulta-
neously browse images on the card and images in the camera.

After inserting the card in a card slot or card reader, follow
these steps to browse images in a compact flash-memory card.

1 Double-click the card icon on the desktop.

The drive window will open on the desktop.
Nikon View Browser:  Browsing Images in Your Camera
2 Drag the “DCIM” folder icon over the Nikon View
Browser icon and release the mouse button.  (Folder
names on the flash memory card vary depending on which
model COOLPIX digital camera you are using.)

Note:  “Nikon View Browser” may be found in the path “(Instal-
lation Disk)|(Installation Folder)|Nikon Software|Nikon View
2|Nikon View Browser.”

Tips

If a compact flash card reader or card drive is mounted as the CoolPix

camera drive (by selecting the Nikon View Control window when mount-

ing the camera), you can use the same operations as when browsing the

camera memory.  See the preceding “Browsing Images in Your Camera” sec-

tion.
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The folders on the card are displayed.

3 Double-click the folder icon that you want to browse.
The browser window will open, showing thumbnail previews
of the images in the selected folder.
Nikon View Browser:  Browsing Compact Flash-Memory Cards
Another way of starting Nikon View Browser
You can also start Nikon View Browser by double-clicking the
Nikon View Browser icon.

A dialog will appear prompting you to select a folder to browse.
Select desired folder and click Select.

Note:  If you copy the Browse Thumbnails icon from the
CoolPix folder to a folder containing images, you can start Nikon
View Browser by double-clicking the copy of the Browse
Thumbnails icon.
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Browsing Images on Disk

Nikon View Browser can also be used to browse JPEG or TIFF
images on disk.  Select the folder containing the images you
wish to browse, drag it over the Nikon View Browser icon
and release the mouse button.

Note:  “Nikon View Browser” may be found in the path “(Instal-
lation Disk)|(Installation Folder)|Nikon Software|Nikon View
2|Nikon View Browser.”
Nikon View Browser:  Browsing Images on Disk
The browser window will open, showing thumbnail previews of
the images in the selected folder.
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Another way of starting Nikon View Browser
Nikon View Browser can also be started by double-clicking the
Nikon View Browser icon.

A dialog will appear prompting you to select a folder to browse.
Choose the desired folder, and then click Select.

Note:  If you copy the Browse Thumbnails icon from the
CoolPix folder to a folder containing images, you can start Nikon
View Browser to view the images in the folder by double-clicking
the copy of the Browse Thumbnails icon.
Nikon View Browser:  Browsing Images on Disk
Selecting images

Images in the browser window can be printed or copied to disk.
The images on which such operations are to be performed can
be selected by clicking the image you wish to use.  Selected
images are highlighted.

Multiple images can be selected by holding down the Shift key
on the keyboard while clicking each image in turn.  All images in
the camera can be selected by choosing Select All from the
Edit menu.

Selected image
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Viewing Images with the Built-in Viewer

Images previewed in Nikon View Browser can be viewed at full
resolution using the browser’s built-in viewer.  The viewer also
offers zoom-in, zoom-out, and scroll functions.

Follow these steps to view images with the browser’s built-in
viewer.

1 To select the built-in viewer as the application used when
opening images from the browser, choose Preferences…
from the browser Edit menu.

The Preferences dialog will appear.
Nikon View Browser:  Viewing Images with the Built-in Viewer
Click the Viewer tab to open Viewer panel.  Select Open
images with built-in viewer and click OK.

2 In the browser window, select the images you wish to view
and double click any of the images or choose Open from
the File menu to start the built-in viewer.
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The selected images will be opened at full resolution in separate
image windows.

Zooming the image in and out
When moved over an image window with the command ( )
key held down, the cursor takes the shape of a magnifying glass
( ).  Click anywhere on the image with the command ( ) key
held down to zoom the image in.  Pressing the option key on
the keyboard changes the cursor to a magnifying glass with
containing a minus sign ( ).  Clicking anywhere in the image
while holding down the option key will zoom the image out.
Nikon View Browser:  Viewing Images with the Built-in Viewer
The image can also be zoomed in and out by clicking the zoom-
in and zoom-out buttons at its lower left corner.  Clicking the
zoom-out button zooms the image out and reduces the size of
the window to fit the image.  Clicking the zoom-in button
zooms the image in and enlarges the window to fit the image.

Note:  Zoom operations have no effect on the thumbnails in the
browser window.

Zoom-out button

Zoom-in button
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Scrolling and resizing image windows
When the entire image does not fit in the image window, you
can view the hidden portion by dragging the scroll boxes at the
right and bottom of the window, or by clicking the scroll bars or
scroll arrows.  If you move the cursor over the image, the
cursor will take the shape of a hand ( ), and the image can be
scrolled by dragging it.

Alternatively, you can enlarge the window itself dragging the size
box at its lower right corner.

Scroll box

Scroll bar

Scroll arrow
Size box

Zoom box
Nikon View Browser:  Viewing Images with the Built-in Viewer
If there is enough space on the desktop, the entire image can
be viewed at its current zoom ratio by clicking the zoom box at
the top right corner of the image window.  The image window
will be either enlarged to show the entire image or, if the image
is larger than the desktop, enlarged to fill the desktop.
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Deleting Images

When browsing images on disk or on a compact flash-memory
card, you can delete images by moving their associated thumb-
nails to the trash.

Note:  Because the camera functions as a locked disk, images in
the camera can not be deleted from the browser.  Use the
camera’s delete option to delete images stored in the camera’s
memory.

Images can be moved to the Trash by dragging their associated
thumbnails over the Trash icon and releasing the mouse button.
Nikon View Browser:  Deleting Images
Images can also be moved to the Trash by selecting their
thumbnails in the browser window and choosing Move to
Trash from the File menu.

To permanently delete the images, select Empty Trash from
the Special menu.
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Tips

In order to open images in compact flash-memory cards, you will need to

use Macintosh PC Exchange or a similar control panel to associate the

DOS file suffix (extension) “.JPG” or “.TIF” with a suitable application.  See

“Opening Images in Another Application,” below.

Printing Images

Images selected in the browser window can be printed by
choosing the Print command from the File menu.  Images
displayed in the built-in viewer can also be printed from the
image window as described below.

Printing images from the browser window
To print images, select the associated thumbnails and choose
Print from the File menu.

If you are opening images currently stored in or that have been
copied from the camera’s memory, the application specified in
the Nikon View Control window will start and the Print dialog
will be displayed.  Make such changes to printer settings as you
desire and print the images.
Nikon View Browser:  Printing Images
Printing from the image window
Images displayed in image windows in the built-in viewer can be
printed by selecting Print Window… from the File menu.

The print dialog box for the printer currently selected in the
Chooser will be displayed.  Print the image after adjusting
printer settings.  If multiple image windows are open, only the
image in the currently active window will be printed.
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Changing the Appearance of Thumbnails

By default, thumbnail previews in the browser window are
displayed in the “No border” style frame.  You can choose to
display images in a document-style frame or with no frame at
all.

1 Select Preferences… from the Edit menu.

The Preferences dialog will be displayed.

2  Click the Appearance tab to open Appearance panel.
Nikon View Browser:  Changing the Appearance of Thumbnails
3 Choose a frame from the list of Thumbnail Border radio
buttons.

(No border)
When this button is selected,
thumbnails will be displayed
without a frame.

(Document border)
When this button is selected,
thumbnails will be displayed in a
document-style frame, as shown
at right.

(Film-strip border)
When this button is selected,
thumbnails will be displayed in a
film-strip frame.

4 After choosing the desired style, click OK.

The thumbnails in the browser window will be displayed in
the selected frame.
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Viewing Image Information

You can view information on selected images.  After selecting
the thumbnails, select Get Info from the File menu.

A window with information on the selected image appears.
You can find general information, and photo information in the
information window.  You can switch between the two by using
the Show pop-up menu.
Nikon View Browser:  Viewing Image Information
General information includes file size, file location, capture date,
and dimensions of the selected image.  Further, you can add
comments in the Comments box.  Photo information con-
tains information on camera settings such as camera model,
image quality and metering mode at the time the photograph
was taken.
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Copying Images to Disk

Selected images in the browser window can be copied to disk
by dragging any of the selected thumbnails over the destination
folder and releasing the mouse button.

Note:  Because the camera functions as a locked drive, images
can only be copied, not moved, even if the option key is not held
down.
Nikon View Browser:  Copying Images to Disk
Tips

 All images taken with the camera are assigned file names beginning with

“DSCN0001.JPG (or TIF).”  Likewise, all image files saved in folders in the

camera’s memory are assigned file names beginning with “DSCN0001.JPG

(or TIF).”  Thus, to prevent overwriting when copying an image to disk,

change the filename when you copy an image, or create a new copy folder

for each camera folder.
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Opening Images in Another Application

When a thumbnail is double-clicked or a thumbnail is selected
and Open chosen from the browser File menu, the image will
be opened in the application specified for the purpose in the
Nikon View Control window.  Images can also be opened
directly from any application that supports the file formats used
by the camera.

Tips

When images are read directly from the camera, the creator program is set

to the application specified in the Nikon View Control window.  If the speci-

fied application is installed on your system, double-clicking images in the

camera will open them in the application.  When read directly from the

camera’s flash-memory cards, however, images are treated as DOS files

with no creator.  In order to open such images with a double click, you will

need to use Macintosh PC Exchange or a similar control panel to associate

the DOS file suffix (extension) “.JPG” or “.TIF” with suitable application.

The same restriction applies to images copied directly from flash-memory

cards.
Nikon View Browser:  Opening Images in Another Application
Opening selected images from the browser
Follow these steps to open images with the specified applica-
tion.

1 To choose settings so that images are opened using the
designated application, choose Preferences… from the
browser Edit menu.

The Preferences dialog will appear.

Click the Viewer tab to open Viewer panel.  Select Open
images with their normal application and click OK.
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2 In the browser window, select the images you wish to open
by clicking their thumbnails, then double-click any of the
selected thumbnails or choose Open from the File menu.

The selected images will be opened in windows within the
associated application.
Nikon View Browser:  Opening Images in Another Application
Tips

The application used to open camera image files is the one that you se-

lected in the Nikon View Control Window, when you mounted the camera.

If you selected the default “Nikon View Browser,” it will start, and you can

view images at full resolution using the browser’s built-in viewer.  If you

chose another application, that application will start, and open the images.

If the specified application is not installed when you attempt to open an

image, a dialog will appear prompting you to choose the application to be

used.  Choose a suitable application from the dialog box.
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Opening selected images by drag and drop
Selected images can be opened in any application that supports
the file formats used by the camera by dragging their thumbnails
over the application’s icon or alias and releasing the mouse
button.

The application will start and the selected images will be
opened in windows within the application.
Nikon View Browser:  Opening Images in Another Application
Opening images from the application’s Open dialog
Images in the camera can be opened from any application that
supports the file formats used by the camera by choosing
Open… or Open File… from the application’s File menu.  In
the Open dialog, navigate to the Desktop, select the “CoolPix ”
drive, and click the Open button.  The folders in the camera
memory are displayed; choose the one you want and click the
Open button.  The images in selected folder will be listed.  If
the application’s Open dialog supports preview display, a pre-
view of the image currently selected will appear in the dialog
box.

Select the image you wish to open and click the Open button
to open the image in the application.

Note:  Previews is only displayed in the Open dialog box if the
Create Thumbnails item in the Nikon View Control window
was checked when the camera was mounted.
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Nikon View Reference

This chapter provides a brief reference guide to Nikon View’s
windows and menus.  Refer to this guide when you want to
know the meaning of a command.

Nikon View Control Strip Item

When Nikon View is installed, a Nikon View item is added to the
Macintosh control strip (note that as not all Macintosh comput-
ers support the control strip function, you may not be able to
use this item on your computer).  This item can be used for
easy access to such operations as mounting and unmounting the
camera.

Tips

If the control strip is not visible on the desktop, it can be displayed by

choosing Control Strip from the Control Panels submenu of the Apple

menu and selecting the Show Control Strip radio button.
Nikon View Reference:  Nikon View Control Strip Item
The functions of the Nikon View item are described below.

when the camera is not mounted:

when the camera is mounted:

Open Nikon View Control
Opens the Nikon View Control window, which can be
used to mount or unmount the camera and make
changes to such options as connection port and port
speed.

Mount Camera Now
Mount the camera currently connected to the computer’s
modem/printer port.

Unmount Camera
Remove a currently mounted camera from the desktop.
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The Browser Window
This is the Nikon View Browser window.  The browser window shows image files in the camera’s memory, compact flash-memory
cards, or any other drive or folder as thumbnail previews.  Images can be opened by double-clicking a thumbnail or copied to disk
by drag-and-drop.  Window operations are detailed in “Nikon View Browser.”

Menu bar

Thumbnail
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The Menus

The menus in the menu bar allow you to manage images in the
camera’s memory or in other folders.  The commands available
in each menu are outlined below.  A more complete descrip-
tion of the tasks that may be performed using the menu com-
mands may be found in the chapter, “Nikon View Browser.”

The Apple Menu ( )

In addition to the usual Apple menu items, the Apple menu
contains an About Nikon View Browser… option when
the browser window is active.

About Nikon View Browser…
Gives copyright information for Nikon View Browser.  Click
anywhere within the About dialog box to clear it from
the screen.
Nikon View Reference:  The Browser Window
The File Menu

New Folder ( N)
Creates a new folder.  Note however that as the camera
is locked, this command is not available for images in the
CoolPix folder.

Open ( O)
Opens selected images in the built-in viewer or in the
creating application, depending on what settings have
been chosen in the Preferences dialog box.
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Print ( P)
Selected images will be opened in the creating application,
and the application’s Print dialog will be opened allowing
you to make changes to printer settings and print the
image.

Move to Trash
Moves selected images to the Trash.  Note however that
as the camera is a locked drive, this command is not
available for images in camera memory.

Close Window ( W)
Closes the browser window.  Clicking the close box at
the left end of the title bar has the same effect.  Closing
all browser windows ends your current session of Nikon
View Browser.

Get Info ( I)
DIsplays information on the selected image file.

Label
Changes the label for the selected files.

Sharing…
This command cannot be selected from the browser
window.

Duplicate ( D)
Creates copies of the selected files or folders.  Note
however that as the camera is locked, this command is
not available for images in camera memory.
Nikon View Reference:  The Browser Window
Make Alias ( M)
Creates an alias for the selected files or folders.  Note
however that as the camera is locked, this command is
not available for images in camera memory.

Put Away ( Y)
Returns files that have been placed on the desktop to the
browser window.  This command can be used when you
have selected items on the desktop in the Finder.  Note
however that as the camera is locked, this command is
not available for images in camera memory.

Find ( F)
Displays Find File dialog box.

Show Original ( R)
This command cannot be selected from the browser
window.

Page Setup…
Brings up a dialog box which allows you change printer
settings such as paper size and orientation.

Print Window…
Prints the browser window.

Quit ( Q)
Closes browser windows and ends your current session
of Nikon View Browser.
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The Edit Menu

Can’t Undo ( Z)
Cut ( X) / Copy ( C) / Paste ( V) / Clear

These commands are not available in the browser win-
dow.

Select All ( A)
Selects all the images in the browser window for copying,
printing, or deletion.

Show Clipboard
Displays the contents of the clipboard.

Preferences…
Opens the Preferences dialog box, where you can choose
whether to open images in the built-in browser or in
another application and set the appearance of the thumb-
nails in the browser window.
Nikon View Reference:  The Browser Window
The View Menu

as Icons / as Buttons / as List
as Window / as Pop-up Window / Clean Up

These commands cannot be accessed from the browser
window.

Arrange
Orders the thumbnails in the browser by name, date
modified, date created, size, kind, or label.

View Options…
Opens the View Options dialog for the browser window.
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The Special Menu

Empty Trash…
Deletes all items in the Trash.

Eject Disk
This command is not available in the browser window.

Erase Disk…
This command is not available in the browser window.

Sleep
Puts the system into sleep mode.  Normal operation can
be restored by pressing any key on the keyboard.

Restart
Ends the current session of Nikon View Browser and any
other open applications and restarts the system.

Shut Down
Ends the current session of Nikon View Browser and any
other open applications and turns off the computer.
Nikon View Reference:  The Browser Window
The Help Menu

About Balloon Help…
Provides an explanation of the Finder’s “Balloon Help”
function.

Show Balloons/Hide Balloons
Turns Balloon Help on or off.
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